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KATA PENGANTAR 
 

Assalamualaikum Wr Wb 

 

Segala puji dan syukur kami sampaikan kehadirat Allah SWT, 

yang telah melimpahkan rahmat, taufiq dan hidayah Nya 

kepada kami sehingga buku yang berjudul “Optimalisasi 

Kinerja Sistem Multiakses Ruangan Terintegrasi dengan 

Web Server Berbasis RFID“ karya Filda Angellia., SKom., 

MMSI dan M.Febriansyah., ST., MT ini dapat selesai dan 

terbit. 

Saat ini banyak terjadi pemakaian ruang yang bukan hak 

pakainya sehingga diperlukan penataan dan pendataan yang 

baik agar hak akses terhadap suatu ruangan dapat jelas dan 

teratur. Kami menganalisis bahwa Pendekatan RFID (Radio 

Frequency Identification) hadir sebagai salah satu solusi yang 

dapat menyelesaikan masalah tersebut. Hal tersebut dikuatkan 

lagi dengan adanya perkembangan database multiakses yang 

mendukung optimalnya kerja perangkat akses ruang kelas 

tersebut dengan berbasis RFID. 

Buku ini memaparkan bagaimana cara menganalisis dan 

merancang sebuah database jaringan berbasis RFID, dimana 

RFID itu sendiri adalah sebuah alat yang dapat mendeteksi 

dan mengidentifikasi sebuah objek melalui data transmisi 

dengan mengunakan gelombang radio. Dengan buku ini, 

pembaca diharapkan mendapatkan gambaran umum solusi 

yang harus ditempuh untuk menyelesaikan masalah serupa 

dan akan dapat mengembangkan pemodelan lainnya di 

kemudian hari. Selamat membaca buku ini.  

 

Wassalamualaikum Wr Wb 



INTISARI 

Proses pemakaian kelas di Institut Bisnis dan Informatika 

Kosgoro 1957 masih manual. Hal ini menyebabkan terjadinya 

bentrok jadwal. Identity Card dosen dengan penerapan 

teknologi basis RFID (Radio Frequency Identification) 

berbentuk tag card bisa dijadikan solusi dalam kontrol 

reservasi untuk membuka ruang kelas yang sudah terdaftar 

pada sistem. Diharapkan dengan penggunaan RFID card ini 

dapat menjadi sistem akses ke ruang kelas untuk 

meningkatkan efektifitas prosesnya. Metode penjaringan data 

dengan menggunakan metode observasi dan studi literasi/studi 

pustaka. Prototype smart class dibangun atas beberapa 

komponen yaitu Board NodeMCU ESP32 DevKitV1, Modul 

RFID RC522 + RFIDTags (13.56 MHz), Modul LCD + i2C, 

Motor Servo, PHP + MySQL, Adaptor/Power supply, dan 

Wlan/Router. Sistem multiakses ruangan kelas disinkronisasi 

dengan data jadwal dan ruang kelas serta ID Dosen yang ada 

pada Sistem Akademik. Sistem reservasi ruangan yang dibuat 

digunakan sebagai kontrol penggunaan ruangan, Tiap-tiap 

dosen memiliki satu kartu sebagai alat akses ruangan. RFID 

Card yang telah terdaftar bisa untuk membuka pintu dan me-

record data kehadiran. Sistem multiakses ruangan kelas 

digunakan pula untuk mengawasi penggunaan ruangan 

melalui fasilitas web  sebagai sistem multiakses ruangan kelas 

di IBI Kosgoro 1957. 

Kata Kunci : RFID, PHP, MySQL, Multiakses 



 

1 
PENDAHULUAN 

 

Era tekhnologi komputerisasi saat ini semakin 

berkembang sejalan dengan kebutuhan manusia yang 

terus meningkat. Setiap sistem kerja dituntut untuk dapat 

beroperasi dengan cepat dan akurat.  

Berdasarkan hasil penelitian sebelumnya yang peneliti 

sudah laksanakan pada penerimaan Penelitian Dosen 

Pemula tahun 2020 berjudul “Pemanfaatan Database 

Jaringan Untuk Optimalisasi Akses Pemakaian 

Ruang Kelas di Perguruan Tinggi berbasis RFID 

(Radio Frequency Identification)” telah menghasilkan 

sebuah prototipe alat berbasis RFID memanfaatkan 



database jaringan untuk akses pemakaian ruang kelas 

yang sudah bisa diuji cobakan pada 1 (satu) pintu kelas.  

Dengan prototipe sistem berbasis RFID yang sudah 

berjalan saat ini, masih terdapat beberapa permasalahan 

yang timbul antara lain adalah belum diketahui jelas 

tentang kestabilan dan konsistensi kinerja sistem yang 

berjalan jika diterapkan menggunakan sistem multi akses 

pada sejumlah pintu lainnya. Hal itu terjadi karena pada 

prototipe sistem berbasis RFID baru dijalankan untuk uji 

coba kelayakan hanya pada satu pintu saja, maka peneliti 

memerlukan penelitian lebih lanjut lagi tentang 

kestabilan dan konsistensi kinerja sistem serta 

kehandalan database jaringan pada alat berbasis RFID 

tersebut, jika digunakan pada beberapa ruang kelas 

secara bersamaan (multi akses). Untuk itu tim peneliti 

berencana melanjutkan penelitian tersebut untuk 

menggenapkan sisi keilmuan dan menyempurnakan 

proses pemanfaatan prototipe alat yang dibuat 

sebelumnya, Tim peneliti saat ini mengajukan usulan 

dengan judul “Optimalisasi Kinerja Sistem Multi 

Akses Ruangan Kelas Terintegrasi Dengan Sistem 



Akademik berbasis RFID (Radio Frequency 

Identification)”  

RFID atau biasa disebut Radio Frequency Identification 

adalah sebuah perangkat telekomunikasi data dengan 

menggunakan gelombang radio untuk melakukan 

pertukaran data antara sebuah reader dengan electronic 

tag yang ditempelkan pada suatu objek tertentu [3], [4]. 

RFID adalah alat dengan teknologi frekuensi gelombang 

radio yang dapat membaca sebuah atau sederetan 

informasi dari alat yang kita sebut dengan RFID Tag 

Card dan merupakan suatu kemajuan teknologi dengan 

fungsional identifikasi yang sangat mudah digunakan 

(relatif lebih fleksibel). RFID memiliki kombinasi mutu 

yang unggul yang tidak dimiliki pada perangkat 

teknologi identifikasi lainnya. RFID tag card memiliki 2 

jenis tipe, yaitu tipe Read Only dan tipe Read/Write. 

RFID tidak membutuhkan kontak langsung atau bantuan 

cahaya untuk dapat beroperasi, RFID memiliki level 

integrasi data yang cukup tinggi. RFID memiliki 4 

(empat) bagian, antara lain RFID Reader, RFID Tag 

Card, Antena, dan Software Aplikasi [5]. Berdasarkan 

catu daya, RFID Tag Card digolongkan menjadi: 



 

a. Tag Card Aktif 

Yang menggunakan baterai pada rangkaian yang 

berguna untuk memancarkan gelombang radio pada 

reader agar reader dapat membaca data setiap waktu. 

b. Tag Card Pasif 

Yang tidak menggunakan baterai internal seperti pada 

tag aktif. Tegangan untuk mengaktifkan tag ini berasal 

dari RFID Reader. 

 

 

Gambar 1. Tag Card Pasif. 

(Sumber: https://abisabrina.wordpress.com/) 

 

Sebuah reader akan terhubung langsung dengan 

mikrokontroler, dimana sebuah mikrokontroler  

berfungsi sebagai pengolahan data yang bersumber dari 

https://abisabrina.wordpress.com/


reader. Cara kerja sebuah RFID dapat diilustrasikan 

seperti gambar berikut ini: 

  

Gambar 2. Ilustrasi Cara kerja RFID reader dengan 

RFID tag. 

 

Gambar 3. RFID reader  

 



 

Gambar 4. RFID Tag (ID Card Dosen Sebagai RFID 

Tag) 

 

Bekerjanya RFID ini juga tidak terlepas dari teknologi 

sensor yaitu alat pendeteksi, pengukur atau penyimpan 

perubahan besaran fisika, seperti misalnya besarnya 

panas, besarnya radiasi, perpindahan tempat atau posisi 

dan lainnya untuk dirubah menjadi suatu informasi yang 

nantinya dapat diolah kembali [6]. Beberapa jenis sensor 

antara lain: 

 

a. Sensor Magnetic Switch  

Merupakan perangkat input berbentuk seperti saklar 

yang memiliki hubungan kontak yang sensitif terhadap 

adanya medan magnet.  

 

 



b. Sensor Passive Infra Red / Sensor PIR 

Sensor ini merupakan suatu sensor yang berkinerja 

dengan signal infrared yang dikeluarkan/dipancarkan 

oleh suatu objek. 

Tingkat keakuratan RFID dapat diartikan sebagai level 

kesuksesan atau keberhasilan suatu pembaca RFID yang 

mengidentifikasi tag pada area kinerjanya [7]. Tingkat 

kesuksesan dari sebuah proses untuk identifikasi sangat 

dipengaruhi hal yang bersifat batas fisik [3], antara lain 

yaitu letak antena pada pembaca RFID, Sifat atau 

karakter material pada lingkungan yang melingkupi 

suatu sistem RFID, dan batas catu daya dan nilai 

frekuensi kinerja sistem RFID [8]. 

Pada perancangan perangkat akses “Pemakaian Ruang 

Kelas di Perguruan Tinggi berbasis RFID (Radio 

Frequency Identification)” ini, pada bagian server 

menggunakan aplikasi perangkat lunak yang 

dikembangkan dengan bahasa PHP. PHP adalah sebuah 

bahasa pemrograman server-side dan merupakan bahasa 

skrip yang dapat ditanamkan ke dalam HTML serta 

digunakan untuk membangun CMS. Aplikasi perangkat 

lunak pada perancangan ini terhubung dengan jaringan 



wifi kampus (terkoneksi ke internet) dan berbasis Web 

Server untuk sistem akademiknya. Pada database server 

sendiri akan menggunakan MySQL. 

Perancangan sistem RFID membutuhkan beberapa item 

atau komponen standart untuk mencapai suatu 

fungsional aplikasi yang optimum [2]. Pada proyek 

perancangan fungsional tersebut antara lain : 

 

1. Proses Penyimpanan Database 

Komponen atau item yang digunakan pada fungsional ini 

misalnya database desktop sub komponen dbsource yang 

berasal dari data access, dbgrid dari  data kontrol, tabel 

data dbe, dan data kontrol. 

 

2. Sampling data Tanggal dan Waktu 

Hal ini digunakan sebagai fungsi pengatur waktu dari 

sebuah sistem. 

 

3. Komunikasi wifi 

Jaringan komunikasi data antara NodeMcu Esp32 

DevKitV1 sebagai akses pengendali ruangan dengan 

database server MySQL sebagai database pemakaian 



ruangan menggunakan media WIFI yang terhubung 

dengan internet. 

 

4. Database 

Mencakup susunan data-data yang diorganisasikan serta 

disimpan, yang penyimpanannya dilakukan dengan cara 

terintegrasi dengan metode pada komputer yang 

memiliki kemampuan untuk memenuhi kebutuhan 

informasi dengan optimal.  

 

5. Web server   

Web server adalah sebuah software (perangkat lunak) 

yang memberikan layanan berupa data. Berfungsi untuk 

menerima permintaan HTTP atau HTTPS dari klien atau 

kita kenal dengan web browser (Chrome, Firefox). 

Selanjutnya ia akan mengirimkan respon atas permintaan 

tersebut kepada client dalam bentuk halaman web. 

Dalam hal ini bertindak selaku webserver adalah sebuah 

sistem informasi akademik kampus. 

 

6. Mikrokontroler 

Fungsional penting sebuah mikrokontroler adalah 



mengontrol berjalannya operasi pada mesin yang 

berbentuk model algoritma dalam bahasa rakitan 

(assembly), kemudian dikonversi menjadi kode mesin 

digital yang tersimpan pada ROM. Mikrokontroler 

memiliki fitur antara lain adalah ALU, SP, PC dan 

register (ROM, RAM, input/output paralel dan 

input/output pencacah (counter seri)). 

 

 

 

 



 

2 
TAHAP 

PERANCANGAN  

DATABASE JARINGAN 

BERBASIS RFID 
 

 

Metode penelitian ini dengan Observasi langsung pada 

objek penelitian di Bagiaan Administrasi Akademik 

(BAAK) IBI Kosgoro 1957 dan juga dengan studi 

pustaka yang detail mengenai rangkaian alat dan sistem 

RFID dimana Radio Frequency Identification adalah 

bentuk pengembangan wireless technology sebagai 

pengganti dari model teknologi scan barcode. Teknologi 



model ini memanfaatkan gelombang pada frekuensi 

transmisi radio untuk dapat identifikasi  objek tertentu 

dalam bentuk tag/transponder (transmitter dan 

responder). Proses identifikasi pada tahapan kerja RFID 

adalah automatic process yang bertujuan agar data yang 

melalui proses transmisi oleh sebuah tag RFID dan pada 

suatu waktu akan terbaca oleh suatu RFID reader yang 

selanjutnya akan diproses menyesuaikan dengan 

kebutuhan aplikasi yang akan dibuat. Penerimaan data 

oleh RFID reader adalah rangkaian proses transmisi data 

dari sebuah tag. Data membentuk rangkaian nomor unik 

yang berisikan informasi identitas data yang digunakan 

pada aplikasi yang kita sebut ‘kartu cerdas’ (smart card), 

seperti proses mencari lokasi, maupun proses untuk 

menghasilkan informasi yang cukup spesifik  pada suatu 

produk dengan model tag[5] . 

 

Tag yang ada pastinya akan memiliki susunan nomor 

yang cukup unik dan pastinya akan berbeda antara 

nomor yang satu  dengan nomor lain, maka RFID ini 

dikategorikan sebagai teknologi yang cukup aman 

karena sulit untuk dipalsukan. Berkaitan dengan hal 



tersebut maka saat ini banyak bermunculan aplikasi 

serupa. Sistem RFID mempunyai 3 komponen utama 

yaitu RFID Tag, RFID reader, dan komputer[4], dapat 

terlihat di blok diagram RFID pada gambar 5 berikut ini. 

 

 

 

Gambar 5. Diagram Sistem RFID. 

 

RFID Tag dapat terbagi menjadi 3 (tiga) jenis berdasar 

pada frekuensi yang dipakai terlihat pada tabel 1, 

kemampuan proses pembacaan dan penulisan, serta 

sumber energi yang digunakan[2]. 

 

 

 



 

Tabel 1. Jenis Frekuensi RFID 

No Frekuensi RFID Jenis Frekuensi 

1 125KHz – 134KHz Low Frequency 

2 13.56MHz High Frequency 

3 860MHz – 930MHz Ultra High Frequency 

4 2.4GHz Micro-Wave 

 

Prinsip tahapan kerja dari RFID adalah sebuah reader 

akan memancarkan suatu gelombang radio jika tag RFID 

ada dalam suatu jangkauan suatu gelombang dengan 

frekuensi radio tersebut, maka dikatakan sebuah chip 

yang ada pada RFID tag akan dimunculkan melalui suatu 

tegangan induktansi yang akan dapat memberi respon 

balik, yaitu  RFID Tag yang akan serta merta mengirim 

suatu nomor unik yang dapat tersimpan didalam model 

tersebut secara wireless ke RFID reader untuk di proses 

baca[3] kemudian reader akan memforward data yang 

terbaca ke host komputer yang terhubung reader.  

Tahapan pada proyek perancangan adalah 

mengumpulkan data-data yang dilakukan dengan 

beberapa cara diantaranya adalah sebagai berikut  : 



1. Observasi atau studi lapangan 

Dengan melakukan survey langsung serta wawancara di 

lingkungan Institut Bisnis dan Informatika Kosgoro 1957 

dengan cara survey atau melihat langsung bagaimana 

sistem yang berjalan dan seperti apa sistem yang butuh 

untuk dikembangkan terkait dengan penjadwalan 

pemakaian ruang kelas di kampus tersebut. 

 

2. Studi Pustaka 

Proyek perancangan yang juga dilakukan dengan 

mempelajari literatur pada buku atau jurnal yang setipe 

dengan proyek perancangan yang dibuat ini. 

3. Proses Desain Hardware dan Pembuatan Hardware; 

4. Uji Operasional Hardware; 

5. Proses Desain dan Pembuatan Software ; 

6. Uji Operasional Software; 

7. Uji Sistem Hardware dan 

 

Dalam proyek perancangan ini upaya pencarian data dan 

juga observasi dilakukan di lingkungan Kampus Institut 

Bisnis dan Informatika Kosgoro 1957 khususnya 

wawancara di area bagian pengaturan dan jadwal dan 



pelayanan akademik yaitu di BAAK (Bagian 

Administrasi Akademik) untuk sinkronisasi data jadwal 

penggunaan ruang kelas di kampus tersebut. 

Dalam membuat rancang bangun sistem ini perlu 

dikemukakan model yang digunakan, antara lain yaitu : 

 

1. Teknik Pembuatan Flowchart untuk memperinci 

alur sistem yang berjalan dan yang akan dibuat 

2. Teknik pemodelan perancangan sistem 

terstruktur untuk memperinci keseluruhan sistem 

3. Software (perangkat lunak) yang digunakan 

untuk aplikasi sistem akademik adalah berbasis web dan 

menggunakan database MySQL serta NodeMcu Esp32 

DevKitV1 pada bagian perangkat elektroniknya. 

 

Teknik Perancangan dengan metode SDLC (Sytem 

Development Life Cycle) yang akan meliputi proses 

sebagai berikut : 

 

1. Planning (proses menyusun rencana) 

Tahap ini adalah tahapan persiapan dengan melakukan 

observasi langsung, pengambilan data. 



2. Proses Menganalisa sistem 

Tahapan yang dilakukan adalah menganalisa data hasil 

observasi dan pengolahan untuk lebih merinci 

bagaimana rangkaian proses sistem berjalan saat ini dan 

apa yang dibutuhkan user di masa mendatang pada 

sistem penjadwalan pemakaian ruang kelas ini. 

 

3. Desain  

Pada tahap ini dibuatlah rancangan-rancangan gambaran 

sistem untuk dapat mensimulasikan alur sistem. Bahan 

pada proyek perancangan ini adalah: 

a. Board NodeMcu Esp32 

Sebagai perangkat akses Pemakaian Ruang Kelas. 

Perangkat ini ditempatkan pada setiap ruangan kelas 

(konsep embedded system) dengan menggunakan 

media komunikasi WIFI yang mampu untuk 

terintegrasi dengan jalur internet. Board NodeMcu 

Esp32 merupakan sebuah open source platform IoT 

dan pengembangan kit yang menggunakan bahasa 

pemrograman Lua untuk membantu dalam membuat 

prototype produk IoT dan bisa diprogram dengan 

menggunakan Arduino IDE. Penggunaan board 



NodeMcu Esp32 menjadikan perangkat lebih 

kompatibel karena fitur mikrokontroler jenis ini 

sudah terdapat modul WIFI serta Bluetooth untuk 

berkomunikasi dengan perangkat lainnya. NodeMcu 

Esp32 DevKitV1 adalah mikrokontroler dari 

Espressif System dan merupakan penerus dari 

NodeMcu Esp8266. Tegangan kerja (operasi) untuk 

NodeMcu Esp32 DevKitV1 adalah 3.3 Volt berbeda 

dengan mikrokontroler jenis lain yang memiliki 

tegangan operasi sekitar 5.0 Volt. Berikut 

perbandingan fitur-fitur yang terdapat didalam 

NodeMcu Esp8266 dengan NodeMcu Esp32 

DevKitV1, yaitu : CPU Xtensa single core L106-

60MHz (Esp8266) dan Xtensa dual core LX6-

160MHz (Esp32), SRAM 160kB (Esp8266) dan 

512kB (Esp32), GPIO untuk pin (ADC/DAC) 

adalah 17(1/-) untuk Esp8266 dan 36(18/2) untuk 

Esp32, SPI/I2C/UART 2/1/2 (Esp8266) dan 4/2/2 

(Esp32) serta yang menarik, pada Esp32 support 

komunikasi dengan media Bluetooth sedangkan 

Esp8266 tidak support. 

 



b. Modul RFID RC522 + RFID Tags. 

Sebagai modul pembaca tag card untuk 

mendapatkan data input. Modul RFID ini memiliki 

spesifikasi frekuensi 13.56 Mhz. Frekuensi 13.56 

Mhz ini adalah frekuensi yang dipergunakan untuk 

smart card dan termasuk jenis high frequency. 

Komunikasi frekuensi radio antara tag dengan 

pembacaan RFID sangat bergantung pada daya yang 

diterima tag dari antena yang terhubung dengan 

pembacaan RFID. Modul RFID RC522 adalah 

sebuah modul RFID dengan menggunakan IC 

MFRC522 yang dapat membaca RFID dengan 

penggunaan yang mudah dan dengan harga yang 

murah. Modul ini dapat langsung terhubung dengan 

mikrokontroler menggunakan interfacing SPI. 

 

c. Kerangka rancangan ruang kelas. 

Sebagai simulasi model untuk memperlihatkan 

proses dan kinerja alat. Untuk memperlihatkan cara 

kerja multi akses pada pintu ruangan, maka 

dibuatlah 3 (tiga) ruang kelas dalam satu papan 

model. Setiap ruang kelas pada papan model 



terdapat 1 modul NodeMcu Esp32 DevKitV1, RFID 

RC522, dan motor servo. 

 

d. Adaptor atau Power Supply. 

Sebagai sumber tegangan kerja untuk peralatan. 

Pada perangkat Akses Pemakaian Ruang Kelas ini, 

terdapat 2 tegangan kerja atau operasional, yaitu 

tegangan 3.3 Volt untuk tegangan operasional 

NodeMcu Esp32 DevKitV1 dan modul RFID 

RC522, serta tegangan operasional 5 Volt untuk 

modul motor servo. 

 

e. Router 

Sebagai jaringan wifi antara NodeMcu Esp32 

DevKitV1 yang berada pada tiap ruangan kelas 

dengan web server dimana perangkat lunak aplikasi 

akademik terdapat berserta database jaringan 

MySQL. 

 

4. Alat (tools) Proyek perancangan 

Terdiri dari perangkat keras dan perangkat lunak.  



perangkat keras (Hardware) terdiri dari perangkat 

Power Supply (berupa Adaptor dengan output 5V 

dan 3.3V), Perangkat Pengunci ruangan kelas 

(Motor Servo), dan Web Sarduinoerver di 

komputer (pengontrol seluruh area plant). 

Perangkat Lunak (Software) untuk perancangan 

sistem ini terdiri dari IDE Arduino, database 

MySQL dan Web Server. 

 

Simulasi Desain Pengujian Hardware; 

1. Tahap 1 

Meregistrasi atau mendaftarkan nomor ID pada database, 

ID ini terdiri dari ID-1 (berasal dari card) dan ID-2 yang 

merupakan ID lokal yaitu ID personal yang biasanya 

terdapat pada indentitas pribadi yang tentunya bersifat 

unik seperti (NIP (Nomor Induk Pegawai)atau 

NIDN(Nomor Induk Dosen Nasional) atau NPM 

Mahasiswa 

2. Tahap 2 

Admin database membuat jadwal pemakaian ruangan / 

memasukkan data jadwal pemakaian ruangan pada 

database. Terkait data dimaksud adalah data yang 



mencakup waktu (hari, tanggal dan jam) pemakaian 

ruangan oleh user tertentu. 

3. Tahap 3 

Melakukan tapping atau mendekatkan tag card ke RFID 

reader, data ID-1 terbaca dan diproses oleh 

mikrokontroler.  

4. Tahap 4 

Selanjutnya mikrokontroler akan membaca data dari 

RFID Tag Card, kemudian jika data RFID (ID-1) telah 

sesuai dengan data ID personal (ID-2). Maka dilakukan 

pendeteksian ID-2 dengan data pada tabel jadwal 

pemakaian ruang kelas, jika sesuai maka mikrokontroler 

dapat memberikan perintah kepada magnetic lock 

sehingga kunci pintu terbuka. 

5. Tahap 5 

Setiap data yang terbaca dan berhasil membuka pintu 

ruangan kelas akan tersimpan ke dalam database jaringan 

pada tabel histori. Data  pada tabel histori ini,  dapat  

dilihat melalui personal computer (PC). Data itu berupa 

aktivitas card yang digunakan oleh dosen sebagai user 

waktu masuk ruangan kelas tersebut.  



Analisis Perancangan Optimalisasi Database Jaringan 

untuk Multiakses Pemakaian Ruangan Kelas di 

Perguruan Tinggi dengan basis RFID ini terlebih dahulu 

melakukan analisis kinerja sistem yang ada dan sistem 

yang nantinya merupakan hasil translasi. Hasil analisis 

awal ini menghasilkan data sebagai berikut : 

Tabel 2. Analisis Kebutuhan User 

No Data yang Diambil Keterangan 

1. Sistem yang 

berjalan 

sebelumnya 

a. Sistem yang berjalan 

sebelumnya di Perguruan 

Tinggi tempat objek 

penelitian peneliti ini adalah 

sistem terkomputerisasi 

namun masih manual sistem 

hanya menggunakan 

database Excel tanpa 

menggunakan tools database 

tertentu lainnya untuk 

pemakaian kelas 

b. Sistem yang berjalan saat 

ini mengandalkan 



keberadaan dan kemampuan 

interaksi manusia yaitu staff 

akademik dengan datanya 

dan staff umum untuk 

membuka pintunya (juru 

kunci) 

c. Sistem yang berjalan saat 

ini membutuhkan rentang 

waktu operasional 

penanganan solusi yang 

sangat lama dalam hal 

membuka atau memakai 

kelas dikarenakan sistem ini 

mengandalkan Human 

Operation 

d. Sistem yang ada saat ini 

sudah menggunakan pilot 

project dari penelitian 

terdahulu yang awal 

dilakukan oleh tim peneliti 

yang sama yaitu kami 



dengan judul Optimalisasi 

Database Jaringan Untuk 

Akses Ruang Kelas dimana 

sistem tersebut baru hanya 

menggunakan 1 akses kelas 

saja dengan menggunakan 

tekhnologi RFID tersebut 

dan sudah dievaluasi sistem 

ini bisa berjalan namun 

masih pada 1 ruang kelas 

saja 

2. Kebutuhan User  a.User membutuhkan sistem 

yang dapat mengakomodir 

perihal membuka kelas 

dalam setiap jam mengajar 

dengan cepat di semua kelas 

b.User membutuhkan sistem 

yang mengakomodir perihal 

keakuratan data kelas dalam 

setiap penggunaan seluruh 

kelas 



3. Spesifikasi Sistem 

baru sebagai solusi 

a. Sistem yang 

memungkinkan dapat 

membantu adalah sebuah 

sistem yang dapat 

mengakomodir kebutuhan 

user utamanya mengenai 

kecepatan dan ketepatan 

operasi proses pemakaian 

kelas secara keseluruhan 

yang dapat terintegrasi 

dengan sistem akademik 

agar dapat mempermudah 

sistem penjadwalan 

pemakaian ruang kelas dan 

menghindari terjadinya 

bentrok pemakaian ruang 

kelas yang terjadi karena 

sistem manual yang 

diajalankan 

 

 



Analisis Perancangan Optimalisasi Database Untuk 

Akses Pemakaian Ruang Kelas di Perguruan Tinggi 

berbasis RFID ini terlebih dahulu melakukan analisis 

kinerja sistem yang ada dan sistem yang nantinya 

merupakan hasil translasi. Analisis tersebut dapat 

divisualisasikan dalam bentuk alur (Flowchart) sistem 

berjalan yang menggambarkan sistem manual yang 

berjalan pada saat ini, dan Flowchart Sistem 

Penjadwalan Ruang kelas dengan menggunakan 

optimalisasi database jaringan berbasis RFID. Sistem ini 

juga didesain dengan menggunakan ERD (Entity 

Relationship Diagram) dan DFD (Data Flow Diagram) 

yaitu merupakan desain sistem terstruktur. DFD 

merupakan model logika data yang dibuat untuk 

mengilustrasikan asal data dan alur tujuan data, tempat 

penyimpanan data, proses apa yang menghasilkan data 

tersebut serta interaksi antara data yang tersimpan dan 

proses yang dikenakan pada data tersebut. 

Menurut Brunch dan Gradnitski, desain sistem dapat 

didefinisikan sebagai penggambaran, perencanaan, dan 

pembuatan sketsa atau pengaturan dari beberapa elemen 

yang terpisah kedalam satu kesatuan yang utuh dan 



berfungsi. Perancangan sistem ini dapat digambarkan 

dan terlihat pada flowchart dan ERD serta Diagram 

konteks sebagai berikut : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Gambar 6. Flowchart Sistem Berjalan 



 

Gambar 7. Flowchart Sistem Optimalisasi Database 

Jaringan dengan Berbasis RFID 
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Gambar 8. Flowchart Cara Kerja RFID 



 

DFD (Data Flow Diagram) sistem ini dibuat dalam 

Diagram Konteks yang menggambarkan sistem secara 

umum, terlihat pada bagan DFD sebagai berikut : 

 

 

Perancangan Database dilakukan dengan merancang 

ERD (Entity Relationship Diagram) sebagai berikut : 

Gambar 9. DFD Penjadwalan Ruang Kelas Berbasis RFID 

 



 

 

 

Rancangan atau desain komunikasi antara RFID dengan 

komputer akan diproses agar perangkat keras (hardware) 

RFID reader ke program yang utama saling terhubung. 

Data yang dikirim oleh RFID Tag dan diterima oleh 

sebuah reader akan diolah dan terhubung dengan 

database pada komputer. Proses baca data di sisi tag oleh 

RFID reader diilustrasikan pada Gambar 11.  

Gambar 10. ERD Penjadwalan Ruang Kelas Berbasis 

RFID 

 



 

Gambar 11. Diagram Desain Komunikasi RFID dan komputer 

 

Penjelasan rangkaian proses baca data pada RFID 

adalah:  

1. Tahapan baca data RFID tag menggunakan frekuensi 

pancaran gelombang radio. 

2. Nomor seri unik yang disimpan pada tag RFID yang 

akan terbaca oleh  reader RFID berikut sususan dari 

angka tiap kartu tidak pernah akan sama antara setiap 

nomornya, 

3. Jika tidak terdapat kesalahan pada proses baca reader 

RFID, maka data tersebut akan dikirimkan kepada 

tampilan komputer tersebut,  

4. Data output  RFID reader saat itu akan langsung 

dikirim ke dalam komputer yang terkoneksi melalui 

jaringan TCP/IP (via wireless access). 

5. Didalam komputer yang berproses tersebut data diolah 

menggunakan pemrograman PHP dengan menggunakan 



database MySQL menyesuaikan dengan database sistem 

akademik 

Ketika tag terbaca oleh RFID reader, maka otomatis tag 

itu akan mengirim rangkaian kode berupa rangkaian 

angka unik yang akan masuk kedalam pembacaan RFID 

reader dan akan diteruskan kedalam perangkat komputer 

sehingga rangkaian angka tersebut terbaca. Proses baca 

tag tersebut oleh sebuah reader dengan memiliki jarak 

pembacaan maksimalnya berjarak 7 cm, sehingga 

apabila tag ada pada jarak diatas 7 cm maka tag tersebut 

tidak akan bisa terbaca oleh reader.  

Perancangan alat dilakukan dengan berdasar pada 

eksperimen RFID. Pengujian jarak baca RFID dengan 

sebuah tag card, memiliki tujuan untuk mengetahui 

berapa  jarak deteksi RFID Tag Card yang dilakukan 

RFID Reader. Uji coba ini dilakukan dengan cara 

melekatkan / mendekatkan RFID Tag Card pada RFID 

Reader dengan jarak tertentu dan diukur. Apabila RFID 

Tag Card terdeteksi oleh RFID Reader maka buzzer pada 

rangkaian tidak akan menimbulkan bunyi. Metode uji 

coba ini dapat terlihat pada Gambar 12. 



 

Gambar 12. Uji Jarak Deteksi RFID Reader 

Seperti yang dilakukan oleh Hendi Handian dalam 

proyek perancangannya pengujian,  RFID tag akan 

dikenali oleh RFID reader pada beberapa jarak posisi 

berbeda dengan jarak optimum sejauh 7 cm dan 

pengguna yang akses ruangan kelas dapat tercatat dalam 

sistem database. Hasil uji jarak kerja  Modul RFID dapat 

terlihat pada tabel berikut. 

 

 

 

 

 



 

Tabel 3. Hasil Uji Jarak Deteksi 

 

Ukuran Jarak Testing Deteksi Alat sensor reader RFID dengan 

menggunakan Tag card 

Sumber : Hasil Uji Coba Penulis 

 

Uji modul Servo pada tahapan ini dapat dilakukan 

dengan  melakukan pengujian sudut dengan program 

perintah ke mikrokontroler untuk proses buka/tutup pintu 

ruangan. Posisi modul servo terpasang di pintu dan 

terhubung ke sebuah mikrokontroler (NodeMcu Esp32 

DevKitV1). Pengaplikasiannya tervisualisasi pada 

Gambar 13. 

Gambar dibawah ini adalah teknis cara kerja pada satu 

akses kelas saja. 



 

 

Gambar 13. Pengujian Buka/Tutup pintu Ruang Kelas 

Menggunakan Motor Servo 

Sumber : Hasil Uji Coba Penulis 

 

Uji coba tersebut menghasilkan Uji sudut untuk 

buka/tutup pintu sebagai berikut : 

Tabel 4. Hasil Uji Sudut Servo 

STATUS SUDUT 
 

POSISI KETERANGAN 

Sistem Standby 00 Terkunci 

 

Kondisi Stand by 

 

User Registrasi 

Tapping 
900 Terbuka Pintu bisa dibuka 

User No Registrasi 

Tapping 
00 Terkunci 

Pintu tetap 

terkunci 

 



Pada tabel tersebut diatas, terlihat penjelasan bahwa jika 

akan melakukan proses membuka pintu ruangan 

dibutuhkan kartu RFID yang sudah terdaftar (User 

Registrasi). Jika kartu yang belum terdaftar (User No 

Registrasi), maka servo ke sudut 00 dan pintu akan tetap 

terkunci. Servo akan dapat terbuka (sudut 900), jika kartu 

RFID sudah terdaftar dan pemakaian ruangan tersebut 

terjadwal pada sistem akademik sesuai ID nomor kartu 

pada penggunaan ruang kelas di database jaringan 

(MySQL). Servo akan dalam kondisi terbuka sampai 

batas waktu sesuai penjadwalan kelas tersebut selesai 

digunakan.    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

3 
PERANCANGAN 

HARDWARE AKSES 

RUANG KELAS 
 

Bab berikut ini membahas mengenai berbagai kebutuhan 

terutama komponen-komponen untuk perancangan 

perangkat keras (Hardware) akses pemakaian ruangan 

kelas. Beberapa komponen utama seperti NodeMcu 

Esp32 DevKitV1, modul RFID RC522 sebagai reader 

pembacaan tag kartu RFID, modul motor servo yang 

digunakan sebagai pengunci pintu ruangan kelas dan 

LCD sebagai menu tampilan untuk notifikasi sistem. 



Berikut diagram sistem dari perangkat akses pemakaian 

ruang kelas di Perguruan Tinggi berbasis RFID. 

 

Gambar 14. Blok diagram sistem 

Peralatan yang dibutuhkan : 

1. Board NodeMCU ESP32 DevKitV1 

2. Modul RFID RC522 + RFID Tags (13.56 MHz) 

3. Modul LCD + i2C 

4. Modul Servo + Driver Servo 

5. Kabel + PCB (Bread Board) + Micro USB Cable + 

Adaptor/Power supply 

6. Wlan / Router 

Cara kerja dari sistem perangkat akses pemakaian ruang 

kelas di Perguruan Tinggi berbasis RFID ini adalah 

sebagai berikut: pertama kali, semua kartu RFID sudah 

dalam keadaan ter”registrasi” oleh admin server. Untuk 



kartu Dosen dengan kartu mahasiswa dan petugas 

gedung, dibedakan pada ID awalnya. Serta seluruh 

ruangan kelas sudah terdaftar ID pada setiap kelasnya. 

Untuk penjadwalan pemakaian ruang kelas secara 

otomatis sudah terintegrasi dengan sistem akademik 

pada layanan kampus menggunakan pemrograman PHP 

dengan menggunakan database MYSQL. 

 

Saat waktu perkuliahan dimulai (Contoh : Senin, jam 

08.00 wib), maka dosen pengampuh matakuliah bisa 

langsung menuju ruang kelas tempat mengajarnya. 

Tahapan selanjutnya, dosen pengampuh dapat 

melakukan “tapping” kartunya pada unit reader RFID 

yang terpasang pada pintu ruangan. Secara otomatis 

sistem akan membaca ID dosen pengampuh tersebut dan 

melakukan validasi pada database jaringan (MySQL). 

Jika sesuai, maka mekanisme servo pada pintu akan aktif 

untuk membuka pintu. Pintu ruang kelas tidak bisa 

dibuka oleh mahasiswa sebelum dosen melakukan 

“tapping” diawal. Selain memberikan akses masuk ke 

ruang kelas. Saat mahasiswa memasuki ruang kelas 

dengan melakukan “tapping”, maka sistem akan 



membaca ID mahasiswa tersebut dan merecord data 

tersebut sebagai penanda kehadiran mahasiswa tersebut. 

Semua aktifitas keluar-masuk kelas ter”record” kedalam 

database MYSQL. Record kehadiran mahasiswa saat 

melalukan “tapping” memasuki ruangan kelas, secara 

otomatis terhubung dengan sistem akademik pada bagian 

absensi mahasiswa. 
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Gambar 15. Diagram rangkaian (a) dan tampilan peralatan (b) 

akses pintu untuk 3 ruang kelas. 

Sumber : Hasil Uji Coba Penulis 



NodeMcu Esp32 DevKitV1 

NodeMcu Esp32 DevKitV1 adalah sebuah 

mikrokontroler yang memiliki fungsi dan fitur lebih 

lengkap dibandingkan dengan mikrokontroler jenis lain 

seperti Arduino maupun dengan NodeMcu Esp8266 

yang sama-sama dari Espressif System. NodeMcu Esp32 

DevKitV1 memiliki lebih banyak pin untuk I/O 

(input/output) yang dapat dipergunakan dan 

mempermudah untuk membuat suatu sistem lengkap 

yang menggunakan banyak pin I/O (input/output). Selain 

itu juga dilengkapi dengan wi-fi dan sebuah Bluetooth 

low energy dua mode. Maka untuk membuat sebuah alat 

yang memerlukan adanya peran wi-fi atau Bluetooth 

tidak perlu menggunakan komponen tambahan sehingga 

tidak memakai banyak ruang dan tentunya hemat biaya. 

Di dalam inti NodeMcu Esp32-WROOM-32 ini terdapat 

mikroprosesor Tensilica Xtensa Dual-Core 32-bit LX6, 

Frequency Clock up to 240 MHz, Flash memori 4 MB, 

SRAM 520 KB, Bluetooth 4.2/BLE, WiFi radio dan 

baseband, 11b/g/n WiFi, RF switch, RF balun, Power 

amplifier, Low noise amplifier (LNA), receive amplifier, 

filters, dan power management modules. 



Board modul NodeMcu Esp32-WROOM-32 dapat 

dipergunakan untuk berbagai kebutuhan perangkat-

perangkat seluler, perangkat-perangkat elektronik, dan 

juga dapat digunakan untuk aplikasi-aplikasi berbasis 

Internet of Things (IoT). 

 

Arsitektur NodeMcu Esp32 

Untuk mengetahui secara detail mengenai susunan blok 

rangkaian pada IC NodeMcu Esp32-WROMM-32, dapat 

dilihat dari gambar berikut : 

 
Gambar 16. Arsitektur NodeMcu Esp32-WROOM-32 



Spesifikasi IC ESP32-WROOM-32 Module 

 Microprosesor Xtensa Dual-Core 32 Bit LX6 

 Freq Clock up to 240 MHz 

 SRAM 520 kB 

 Flash memori 4 MB 

 11b/g/n WiFi transceiver 

 Bluetooth 4.2/BLE 

 48 pin GPIO 

 15 pin channel ADC (Analog to Digital Converter) 

 25 pin PWM (Pulse Width Modulation 

 2 pin channel DAC (Digital to Analog Converter) 

 

Konfigurasi Pin NodeMcu Esp32 DevKitV1 

 

Gambar 17. Pin Konfigurasi NodeMcu Esp32 DevKitV1 



Pin GPIO ESP32 WROOM DevKit V1. 

Pada board ESP32 DevKit V1 terdapat 25 pin GPIO 

(General Purpose Input Output) dengan masing-masing 

pin mempunyai karakteristik sendiri-sendiri. 

Pin hanya sebagai INPUT : 

 GPIO 34 

 GPIO 35 

 GPIO 36 

 GPIO 39 

Pin dengan internal pull up, dapat diseting melalui 

program : 

 GPIO14 

 GPIO16 

 GPIO17 

 GPIO18 

 GPIO19 

 GPIO21 

 GPIO22 

 GPIO23 

Pin tanpa internal pull up (dapat ditambahkan pull up 

eksternal sendiri) : 

 GPIO13 



 GPIO25 

 GPIO26 

 GPIO27 

 GPIO32 

 GPIO33 

 

RFID RC522 

Modul RFID reader RC522adalah sebuah modul 

berbasis IC Philips MFRC522 yang dapat membaca 

kartu RFID dengan harga yang relative mudah dan 

murah, karena modul ini sudah berisi komponen-

komponen bertipe smd. Modul ini dapat digunakan 

langsung oleh MCU dengan menggunakan interface SPI 

dan tegangan kerja sekitar 3,3V. Gambar dibawah 

memperlihatkan tampilan RFID RC522. 



 
Gambar 18. RFID Reader RC522 

 

Spesifikasi RFID RC522 

 Arus dan tegangan operasional : 13-26mA/DC 3.3V 

 Tipe kartu Tag yang didukung : mifare1 S50, 

MIFARE DESFire, mifare Pro, mifare1 S70 

MIFARE Ultralight, 

 Idle current :10-13mA/DC 3.3V 

 Peak current: 30mA 

 Sleep current: 80uA 

 Menggunakan Antarmuka SPI 

 Kecepatan transfer rate data : maximum 10Mbit/s 

 Frekuensi kerja : 13.56MHz 

 Ukuran dari RFID Reader : 40 x 60mm 

 Suhu tempat penyimpanan : -40 – 85 degrees 

Celsius 

 Suhu kerja : -20 – 80 degrees Celsius 

 Relative humidity: relative humidity 5% -95% 

 
 

 



LCD (Liquid Crystal Display) 20 x 4 dan modul I2C 

Liquid Crystal Display adalah komponen yang 

menggunakan kristal cair yang mempunyai fungsi 

sebagai tampilan suatu data, baik karakter, huruf atau 

grafik. 

Fitur pada LCD 20 x 4 : 

 Terdiri dari 20 kolom, 4 baris 

 Dimension = 98 x 60 x 13.6 mm 

 Dot Size = 0.55 x 0.55 mm 

 Character Size = 2.95 x 4.75 mm 

 Backlight Type = LED Yellow with Black char 

color 

 LCD Type = STN, Positive 

 Driver = HD44780 

 Supply voltage: 5V 

 Size : 60mm 99mm 

 Contrast Adjust : Potentiometer 
 

 
Gambar 19. LCD 20x4 dengan I2C 

Pin-pin pada LCD 20 x 4 : 

 GND : catu daya 0Vdc 



 VCC : catu daya positif 

 Constrate : untuk kontras tulisan pada LCD 

 RS atau Register Select : untuk mengirim data 

(high), untuk mengirim instruksi (low) 

 R/W atau Read/Write : mengirim data (high), 

mengirim instruksi (low), disambungkan dengan 

low untuk pengiriman data ke layar 

 E(enable) : untuk mengontrol ke LCD ketika 

bernilai LOW, LCD tidak dapat diakses 

 D0 – D7 : data bus 0 – 7 

 Backlight + : disambungkan dengan VCC untuk 

menyalakan lampu latar 

 Backlight - : disambungkan ke GND untuk 

menyalakan lampu latar 
 

Untuk menghemat pin pada Arduino, diperlukan modul 

tambahan sebagai antarmuka yaitu I2C sehingga hanya 

membutuhkan pin SDAdan SCL. 

Spesifikasi modul : 

 Tegangan beroperasi Antara 2-5 Vdc 

 Kompatibel dengan semua jenis mikrokotroller 

 Kendali 8 bit menggunakan antarmuka I2C 

 Open-drain interrupt output 

 
Gambar 20. Modul I2C 



Pin koneksi ke Arduino : 

 GND  : terhubung dengan GND Arduino 

 VCC : terhubung dengan 5V 

 SDA : terhubung dengan pin SDA (A4) 

 SCL : terhubung dengan pin SCL (A5) 
 

Motor Servo 

Motor servo merupakan perangkat yang terdiri dari 

motor DC, serangkaian gear, rangkaian kontrol dan 

potensiometer. Serangkaian gear yang melekat pada 

poros motor DC akan memperlambat putaran poros dan 

meningkatkan torsi motor servo, sedangkan 

potensiometer dengan perubahan resistansinya saat 

motor berputar berfungsi sebagai penentu batas posisi 

putaran poros motor servo. Sedangkan sudut dari sumbu 

motor servo diatur berdasarkan lebar pulsa yang dikirim 

melalui kaki sinyal dari kabel motor servo. 

Bentuk Fisik Motor Servo dapat dilihat pada Gambar. 

 

 

 

 

 

 

 

Gambar 21. Bentuk fisik servo 



 

Prinsip Kerja Motor Servo 

Prinsip kerja motor servo hampir sama dengan motor DC 

yang lain. Hanya saja motor ini dapat bekerja searah 

maupun berlawanan jarum jam mulai dari gerakan 0 

derajat, 90 derajat, 180 derajat, hingga 360 derajat. 

Derajat putaran dari motor servo juga dapat dikontrol 

dengan mengatur pulsa yang masuk ke dalam motor 

tersebut. 



Gambar 22 .Gelombang pulsa beserta rotasi pada servo 

Motor servo akan bekerja dengan baik apabila pin 

kontrolnya diberikan sinyal PWM dengan frekuensi (f) 



50 Hz atau dengan periode (t) 20 ms. Frekuensi tersebut 

dapat diperoleh ketika kondisi Ton duty cycle berada di 

angka 1,5 ms. Dalam posisi tersebut rotor dari motor 

berhenti tepat di tengah-tengah (0°) atau netral. Pada saat 

kondisi Ton duty cycle kurang dari angka 1,5 ms, maka 

rotor akan berputar berlawanan arah jarum jam. 

Sebaliknya pada saat kondisi Ton duty cycle lebih dari 

angka 1,5 ms, maka rotor akan berputar searah jarum 

jam seperti diperlihatkan pada gambar diatas. 

 

 

Cara Pemrograman NodeMcu Esp32 DevKitV1 

Dengan Menggunakan Arduino IDE 

Untuk dapat menggunakan software Arduino sebagai 

editor program dari IC NodeMcu Esp8266, Esp32 

ataupun STM32, maka terdapat langkah-langkah yang 

harus dilakukan sehingga Arduino IDE bisa melakukan 

”upload” program ke board selain Arduino tersebut, 

termasuk board NodeMcu Esp32 DevKitV1, yaitu : 

1. Jika software Arduino IDE belum ter-install di 

komputer atau laptop, silahkan install dilink berikut 

: https://www.arduino.cc/en/software 

https://www.arduino.cc/en/software


2. Jalankan Arduino IDE setelah ter-install. 

 

Gambar 23. Tampilan Arduino IDE 

3. Buka menu File > Preferences, perhatikan gambar 

berikut! 

 

Gambar 24. Menu Preferences Arduino IDE 

4. Pada kolom “Additional Boards Manager URLs:” 

isikan : 

https://dl.espressif.com/dl/package_esp32_index.json 



 

Gambar 25. Additional Boards Manager URLs 

5. Buka Board Manager dari menu Tools > Board > 

Boards Manager… 

 

Gambar 26. Menu Boards Manager 



Cari ESP32 pada kolom search, kemudian klik 

“Install”. 

 

Gambar 27. Install Board ESP32 

Pastikan komputer/laptop terhubung dengan 

internet. Tunggu proses downloading selesai. 

6. Setelah selesai, pasang board NodeMcu Esp32 ke 

port USB komputer/laptop. Pilih jenis boardnya dari 

menu Tools > Board > ESP32 Dev Module. 

 

Gambar 28. Pilihan Menu Board ESP32 Dev Module 



7. Pilih Port yang muncul pada menu Tools > Port, 

dan sesuaikan dengan yang ada di Device Manager. 

 

Gambar 29. Pilih Port Untuk Board NodeMcu Esp32 

8. Arduino IDE sudah siap untuk digunakan membuat 

program dan meng-upload ke board NodeMcu 

Esp32 DivKitV1. 

 

Gambar 30. Proses Upload ke Board NodeMcu Esp32 DevKitV1 



 

4 
SISTEM INFORMASI AKADEMIK 

(SIAKAD)  SEBAGAI WEBSERVER  

 

Perkembangan teknologi informasi saat ini membuat 

orang sadar akan pentingnya teknologi dan mencoba 

memahaminya. Salah satu hal yang perlu kamu pelajari 

adalah teknologi web server. Setiap orang tentu sering 

menggunakan browser ketika berjelajah di internet. 

Lantas apa hubungannya web server dengan browser? 

Singkatnya, browser yang sering kamu pakai bertindak 

sebagai klien. Browser akan mengirimkan beragam 



permintaan kepada web server. Itulah salah satu 

hubungannya.  

Pengertian Website 

Sebelum membahas web server, yang harus dipahami 

terlebih dahulu adalah website yang diakses 

menggunakan browser. Website adalah sebuah halaman 

yang menampilkan berbagai macam informasi media, 

mulai dari teks, gambar, suara bahkan video yang dapat 

diakses selama komputer terkoneksi dengan jaringn 

internet. Website tidak hanya dibuat dengan HTML 

(Hyper Text Markup Languange), tapi dipadukan juga 

dengan CSS (Cascading Sytle Sheet) dan PHP 

(Hypertext Preprocessor) untuk mendapatkan tampilan 

menarik dan interaktif. HTML merupakan bahasa yang 

digunakan pada client side, sedangkan pada bagian 

server side menggunakan bahasa PHP karena berkaitan 

dengan bagaimana proses website dijalankan dalam 

kaitannya dengan server. 

Pengertian Web Server 

Di era modern ini tidak afdol jika kamu tidak kenal 

dengan web server. Apalagi jika nanti akan bergelut 

dibidang IT.  



Web server adalah sebuah software (perangkat lunak) 

yang memberikan layanan berupa data. Berfungsi untuk 

menerima permintaan HTTP atau HTTPS dari klien atau 

kita kenal dengan web browser (Chrome, Firefox). 

Selanjutnya ia akan mengirimkan respon atas permintaan 

tersebut kepada client dalam bentuk halaman web. 

Selain itu, kamu harus tahu bahwa web server menjadi 

salah satu kebutuhan user sebab web server memiliki 

kapasitas penyimpanan yang besar dan akses yang cepat. 

Sehingga dapat mencegah terjadinya kesalahan pada 

suatu website maupun aplikasi. 

 

Fungsi Utama dari Web Server 

Seperti yang sudah dijelaskan di atas bahwa teknologi 

yang satu ini berfungsi menerima permintaan HTTP atau 

HTTPS dari klien atau kita kenal dengan web browser 

(Chrome, Firefox). Ia juga akan mengirimkan respon 

atas permintaan kepada client dalam bentuk halaman 

web yang umumnya HTML. 

Jika berbicara secara detail, maka Web Server memiliki 

peran dalam memproses berbagai data yang diminta oleh 

klien (web browser). Kemudian ia memberikan hasil 



atau jawaban berupa dokumen, video, foto, atau beragam 

bentuk berkas lainnya. 

 

Adapun kita pecah menjadi beberapa bagian fungsi dari 

web server: 

 Membersihkan berbagai cache yang terdapat 

pada penyimpanan serta semua dokumen yang tidak 

terpakai lagi. 

 Melakukan pemeriksaan terhadap 

sistem security yang berasal dari permintaan HTTP 

berdasarkan request klien atau web browser. 

 Menyediakan data berdasarkan request atau 

permintaan yang masuk agar dapat menjamin keamanan 

sistem yang berjalan dengan lancar. 

Protokol HTTP dan HTTPS digunakan web server untuk 

dapat berkomunikasi dengan klien. Dengan protokol 

HTTP dan HTTPS, komunikasi antar server dengan 

klien dapat saling terhubung serta dapat dimengerti 

dengan mudah. 

 

 

 



Jenis-jenis Web Server 

Sebagai programmer, kamu wajib tahu juga jenis 

maupun contoh web server yang umum dipakai. Inilah 

beberapa jenis-jenis dari web server adalah sebagai 

berikut. 

 

Web Server Apache 

Web server yang populer dan paling banyak digunakan 

kebanyakan orang, yaitu jenis Apache. Pada awalnya 

Apache didesain guna mendukung penuh sistem operasi 

UNIX. Selain cukup mudah dalam implementasinya, 

Apache juga memiliki beberapa program pendukung 

sehingga memberinkan layanan yang lengkap, seperti 

PHP, SSI dan kontrol akses. Berikut detailnya: 

 

 PHP (Personal Home Page atau PHP Hypertext 

Processor) 

Program semacam CGI, berfungsi memproses teks yang 

bekerja di server. Apache sangat mendukung PHP 

dengan menempatkannya sebagai salah satu modulnya 

(mod_php). Hal tersebut membuat PHP bekerja lebih 

baik. 



 SSI (Server Side Include) 

Perintah yang bisa disertakan dalam bekas HTML. 

Kemudian ia dapat diproses oleh web server ketika 

pengguna mengaksesnya. 

 Access Control 

Kontrol Akses dapat dijalankan berdasarkan 

nama host atau nomor IP CGI (Common Gateway 

Interface). Lalu yang paling umum untuk digunakan 

adalah perl (Practical Extraction and Report Language), 

disupport oleh Apache dengan menempatkannya sebagai 

modul (mod_perl). 

Apache sangat aman dan nyaman untuk digunakan 

karena memiliki beberapa keuntungan seperti proses 

instalasi yang mudah, freeware, dan sistem konfigurasi 

yang masih tergolong mudah. Selain itu ia juga mampu 

bekerja pada sistem operasi open atau closed source. 

 

Web Server Nginx 

Salah satu pesaing unggul Apache yaitu Nginx. Nginx 

dikenal mampu melayani segala macam permintaan, 

seperti request pada dengan tingkat kepadatan lalu lintas 

atau traffic yang sangat padat. Nginx memang lebih 



unggul dari segi kualitas, kecepatan, dan dalam hal 

performanya. 

Nginx memiliki banyak kelebihan dalam hal fitur, di 

antaranya URL rewriting, virtual host, file serving, 

reverse proxying, access control, dan masih banyak lagi. 

 

Web Server IIS 

Web server IIS (Internet Information Services) adalah 

web server yang bekerja pada jenis protokol seperti 

DNS, TCP/IP, atau beragam software lainnya yang 

berguna untuk merangkai sebuah situs. 

 

Web Server Lighttpd 

Programmer asal Jerman telah menciptakan web server 

berbasis open source guna mendukung sistem Linux dan 

Unix. Bila dilihat dari segi keunggulan, web server yang 

satu ini memiliki beberapa keunggulan berdasarkan fitur 

tambahan yang tersedia. Seperti FastCGi, Output-

Compression, FastCGi, dan URL Writing. Jika kamu 

menggunakan web server Lighttpd, kamu akan 

merasakan performa yang lebih cepat dan efektif. 

 



Sistem Informasi Akademik (SIAKAD) sebagai 

Webserver 

Dalam Uji Coba penciptaan alat optimalisasi database 

multiakses ruang kelas berbasis RFID ini menggunakan 

Sistem Informasi Akademik (SIAKAD) sebagai 

Webserver.  

 Adapun alat ini nantinya akan disinkronisasi 

dengan data jadwal dosen mengajar dan pembagian 

ruang kelas yang terdapat pada sistem akademik (siakad) 

kampus IBI Kosgoro 1957. Sinkronisasi sistem ini 

dengan metode web server yang sudah dibahas secara 

teknikal pada pembahasan di atas. Adapun contoh 

tampilan sistem akademik (Siakad) IBI Kosgoro 1957 

adalah sebagai berikut : 

 

Gambar 31. Siakad Master Dosen (ID _Dosen) 



 

Gambar 32. Siakad Jadwal Kuliah dan Ruang Kuliah 

 

Pengujian Akses Layanan WEB Service  

 Pengujian sistem siakad sebagai webserver yang 

dapat terakses sebagai layanan web service dilakukan 

untuk menghubungkan alat/perangkat akses masuk ruang 

kelas dengan basis data berbasis web.  

Tahapan pada proses ini antara lain : 

1. Mengirim data id tag ke alamat basis data 

melalui pembuatan program layanan webservice 

pada program yang akan membaca tag RFID.  

2. Pada pogram itu ditentukan suatu alamat 

(http) yaitu alamat database akses ruang kelas.  

3. Dilakukan modifikasi jumlah karakter id 

tag yang akan dikirim.  



4. Proses modifikasi jumlah karakter 

tersebut dilakukan dengan membatasi jumlah 

karakter-karakter id tag yang di kirim ke basis 

data untuk mempermudah proses integrasikan ke 

sistem database dengan web service.  

5. Setelah itu program berhasil dijalankan 

maka akan ditampilkan pemberitahuan pada 

tampilan terminal yang menandakan reader RFID 

sudah aktif untuk membaca tag yang didekatkan.  

6. Hasil pengujian dengan melakukan 

scaning tag pada reader, sampai id tag terbaca 

dapat ditampilkan pada layar terminal dan 

menyambungkan. Proses menyambungkan 

tersebut menjelaskan bahwa perangkat multi 

akses ruang kelas sedang melakukan pengecekan 

ketersediaan jaringan internet untuk mengakses 

layanan web server agar id tag yang terbaca dapat 

dikirim pada sistem database.  

7. Proses pengecekan dilakukan selama 

sepuluh detik, dan jika tidak dapat terhubung 

dengan layanan web servive pada sistem 

database, maka kontroler akan menampilkan 



pemberitahuan tidak ada koneksi internet yang 

tersambung dengan perangkat dan data tag id 

telah gagal dikirimkan. Selanjutnya dilaksanakan 

proses scaning tag ulang dengan tag yang 

berbeda. Namun pada percobaan ini dipastikan 

bahwa perangkat absensi telah dapat terhubung 

dengan jaringat internet menggunakan jaringan 

WiFi. Percobaan ini dilakukan untuk melihat 

respon balasan yang diterima oleh perangkat 

absensi jika id tag yang terbaca dapat di kirimkan 

ke database multiakses ruang kelas. Respon 

tersebut telah membuktikan layanan web service 

telah berhasil diterapkan pada sistem.  

8. Dimana setiap id tag yang berhasil 

dikirimkan ke database akan menampilkan 

respon masing-masing sesuai dengan 

kepemilikan id tag.  

9. Data untuk setiap kepemilikan id tag 

sebelumnya telah dimanfaatkan oleh sistem basis 

data untuk menentukan anggota yang terdaftar 

dalam database. 

 



Pada tabel dibawah ini menunjukkan identitas dari setiap 

kepemilikan unik id tersebut. Unik id tersebut terdiri dari 

unik id mahasiswa(i) dan unik id dosen. 

 

TABEL 5. ID UNIK PADA TAG RFID UNTUK DOSEN 

No NAMA NIDN UID 

1. 
Filda 

Angellia.,SKom.,MMSI 
0316028502 216028502 

2. 
Nuraini 

Purwandari.,ST.,MMSI 
0301018901 201018901 

3. 
Waskita Cahya 

.,SKom.,MMSI 
0331128504 231128504 

4. 
Achmad 

Fauzi.,SKom.,MMSI 
0330078403 230078403 

5. 
Dra. RR .Aryanti Kristantini 

.,MKom 
0326126302 226126302 

 

TABEL 6. ID UNIK PADA TAG RFID UNTUK MAHASISWA 

No NAMA NPM UID 

1 
MUHAMAD IMAM NUR 

CAHYO 
06201440009 201440009 

2 ASEP WIJAYA 6201540003 201540003 

3 RIDHO RABBANI EL 06201540014 201540014 



4 
NURUL AMALIAH 

RACHMAN 
06201540015 201540015 

5 
FAUZAN FARHAN 

DAYAMA 
06201540019 201540019 

6 RACHMAD MUHAMMAD 06201540024 201540024 

7 IRFAN ALI AKBAR 06201540025 201540025 

8 JULIAN 06201540032 201540032 

9 NOVIAR BAYU SUHADA 06201540040 201540040 

10 ROMI YADI 06201640005 201640005 

11 MUHAMMAD FATHUR R 06201640011 201640011 

12 TRI PURNAMA AJI 06201640014 201640014 

13 IKHSAN DWI SWASONO 06201640015 201640015 

14 
MUHAMMAD ADRIAN 

FAZA 
06201640016 201640016 

15 MUHAMMAD IRAWAN 06201640021 201640021 

16 HERU KURNIAWAN 06201640024 201640024 

17 MEIRANI ATMAJA 06201640025 201640025 

18 RAHMATUL UMMAH 06201640026 201640026 

19 
MUHAMAD FADILAH 

KURNIA P 
06201640028 201640028 

20 AMIRUDIN 06201640029 201640029 

 

Adapun struktur tabel dalam database sistem ini  

terbentuk 4 Tabel utama untuk ineraksi data dalam 

proses menghasilkan hasil VALID pada aktivitas 

multiakses ruang kelas. Tabel tersebut adalah sebagai 

berikut : 

 



Tabel.7   Tabel Dosen 

No Nama Field Type Data Keterangan 

1. NIDN* Int (12) NIDN Dosen 

2. Nama Varchar (30) Nama Dosen 

3. Gelar Varchar(15) Gelar Dosen 

4. Status Varchar (20) Status Dosen 

 

 

Tabel 8. Tabel Alokasi Waktu 

No Nama Field Type Data Keterangan 

1. Kd_waktu* Int (10) Kode Waktu 

2. Jm_Waktu Time Jam  

3. Jm_Mulai Time Jam Mulai 

4. Jm_Selesai Time Jam Selesai 

 

 

 



Tabel 9 .Tabel Mata Kuliah 

No Nama Field Type Data Keterangan 

1. Kd_MataKuliah* Int (10) Kode Mata 

Kuliah 

2. Nm_Matakuliah Varchar(30) Nama Mata 

Kuliah 

3. Sks Int (10) Jumlah SKS 

 

Tabel 10.Ruang 

No Nama Field Type Data Keterangan 

1. No Int (10) Nomor Ruang 

2. Unit Int(10) Jumah Ruang 

3. Lantai Int (5) Nomor Lantai 

4. Ruang Varchar(10) Identifikasi 

Ruang 
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SIMPULAN 
 

Perancangan optimalisasi kinerja sistem multi akses 

ruangan kelas terintegrasi dengan sistem akademik 

berbasis RFID ini merupakan kelanjutan penelitian dari 

Analisis perancangan optimalisasi database akses 

pemakaian ruang kelas di Perguruan Tinggi berbasis 

RFID dengan beberapa perubahan yang menjadi 

kesimpulan dari penelitian saat ini. Berdasarkan desain 

dan perancangan penelitian sebelumnya, maka dapat 

disimpulkan bahwa penggunaan ruang kelas untuk multi 



akses ruangan tidak mampu jika menggunakan aplikasi 

berbasis desktop, terjadi antrian data pada proses 

identifikasi ID dari kartu RFID pada sisi aplikasi 

dekstop. Dalam penggunaan modul pengendali, juga 

terdapat perubahan dari Arduino Uno menjadi NodeMcu 

Esp32 DevKitV1 dimana dari sisi perangkat terdapat 

perbedaan pada modul komunikasi Wifi. Hasil pengujian 

dengan menggunakan perubahan baik jenis 

pemrograman di server serta perubahan dari modul 

pengendali, di dapat hasil yang lebih baik dan 

permasalah bottleneck yang terjadi pada penelitian 

sebelumnya dapat teratasi dengan menggunakan aplikasi 

berbasis Web Server. Penelitian ini masih sangat banyak 

terdapat kekurangan didalamnya sehingga peneliti 

memberi saran agar prototipe ini nantinya dapat 

direalisasikan pada setiap Perguruan Tinggi yang saat ini 

masih memproses secara manual untuk database 

pemakaian ruang kelas. 
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